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Notes 

Each module provides a notes feature that allows you to record and track text-based notes and 

attach a variety of document types to the notes. You can attach Microsoft Word documents, 

Microsoft Excel spreadsheets, Adobe Acrobat PDFs, and virtually any other type of non-

executable file. 

Each primary data entry screen and sub screen in each module has a Category Notes button. 

When the Category Notes button is selected, the notes screen is opened and only notes 

assigned to that particular category can be viewed. For example, to view notes within the 

Personnel Management module that have been assigned to the Personal category, the 

Category Notes button would need to be selected from the primary Personal screen or any of 

the Personal sub screens.  

The Notes screen includes the Note Details grid and the following buttons: Attach, Delete, 

Show and Scan. 

Note: The Category Notes button can be turned off for a user by clearing the Notes check box 

in User Setup. 

Note Details Grid 

The individual notes are displayed in the Note Details grid. This grid contains the columns 

described below. 

User 
Indicates the User ID of the People-Trak user who created the note. This field is 

automatically assigned and is for display only. 

Note Date  
Indicates the date of the note. If you do not enter a note date, the date will be set to today’s 

date. 

Note Text  
The text of the note. The first line of the note is initially displayed. If you wish to display or 

enter additional lines, use the multi-line editor popup button to display the entire text of the 

note. 

Type 
 Indicates the type of file attached to this note, if any. If a note has an attachment, you can 

activate the attachment and start the product used to create or edit the attachment by clicking 

the Show Attachment button. For example, if you have attached a Microsoft Word document, 

the Type will be DOC or DOCX. You can then click the Show Attachment button, which will 

start Word and load the attached document. 

Attachment Buttons 
There are four attachment buttons available on the right hand side of the Notes screen. The 

Attach button is available once a note has been entered on the current row, and allows you to 

select the file to attach to the note. The Delete button is available when on a note that has an 
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attachment, and allows you to delete the attached file. The Show button is available when on 

a note that has an attachment, and allows you to show the attachment. The Scan button is 

available once a note has been entered on the current row, and allows you to utilize your own 

scanner to attach a scanned image.   

All Categories Button 
You can display the notes for all categories by selecting the All Notes button located on the 

right hand side of the Notes screen. All fields on the All Notes screen are display only and 

cannot be modified. Notes can be sorted by any column using standard grid conventions. 

Simply click on the grid header for the column on which you wish to sort. The note rows will 

then be sorted in that order. The Show button is available when on a note that has an 

attachment, and allows you to show the attachment. 

Working With Notes 

Viewing the Entire Text of the Note 
To facilitate navigation and rapid viewing, notes are initially presented as single lines in the 

notes grid. You can move through the rows on the grid using standard grid navigation 

conventions. If you wish to view the entire text of any note, simply position the cursor to the 

desired row and click on the multi-line editor popup button. The entire text of the note is 

displayed in the multi-line editor and may be edited. 

If you just viewed the note or made updates you want to save, click the OK button to return to 

the Notes screen. If you made updates to the note but do not want to save the changes, click 

Cancel. 

Showing Notes for other Categories  
When selecting the Category Notes button on primary and sub screens, the notes for the 

category associated with the primary screen are displayed. You can display and edit the notes 

for other categories by selecting the appropriate primary or sub screen and selecting the 

Category Notes button located on that screen. 

Deleting Notes 
Notes can be deleted using the Delete Row option, which is available on the Edit menu and 

on the Tool Bar. When the Delete Row option is used, the entire note including any 

attachment is deleted.  

Sorting Notes 
When notes are first displayed, the notes are displayed in descending order by note date. 

Notes can be sorted by other columns using standard grid conventions. Simply click on the 

grid header for the column on which you wish to sort. The note rows will then be sorted in 

that order. You can also order the notes in any random order using the Row Up and Row 

Down buttons on the Tool Bar. Like other grids, note rows are stored back into the database 

in the order in which you last sorted them 

In addition, you will notice that when the sort order is changed in one category, the sort order 

persists for the rest of the categories. The primary reason for sorting notes is for viewing and 

printing purposes.   

Printing Notes 
You can print the list of currently displayed notes at any time using the Print button on the 

Tool Bar. If you wish to print a particular list of notes in a particular order, select the 
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appropriate category and sort the list the way you want. The note report will reflect the list as 

you see it. 

Working with Attachments 

People-Trak provides a unique feature that enables you to attach files to your note records. 

These files can be retrieved and viewed at any later time. 

Attachments do not Use Linked Files 
The files that you attach to People-Trak are not stored as linked files. With linked files, you 

simply store the name and path to the original file. If the file is moved, deleted, modified or 

lost, the link is no longer valid and the attachment is lost. In addition, linked files are not 

secure. A linked file that is located by any user can be opened and read at any time. Linked 

files are not a satisfactory method of storing attachments. 

How Attachments are Stored 
With People-Trak, there is one attachment file for each attachment and that attachment file is 

stored in the database. The attachment is a copy of the original file, so you are not dependent 

on the original file. If the original file is lost or deleted, you will always have the copy 

associated with the applicable note record. Should you wish to export the attachment out of 

the attachments file, you can do so using the “Save As” feature of the product.  

Attaching a File 
The process for attaching files is the same process regardless of whether you are attaching 

Word documents, Excel spreadsheets, image files, or any other type of file. 

If the note to which you wish to attach a file does not yet exist, add the note. If the note does 

exist, select the desired note row.  

 

You are allowed one attachment per note. An attachment can only be added if there is no 

existing attachment for that note.  

When a file has been selected, internal processing for the attachment is performed. A copy of 

the file is made, and the file is compressed and moved into the attachment file for the current 

record. The type of file is then added to the Type column of the grid. 

Activating Existing Attachments 
When you have attached a file to a note, the Type column was updated to indicate the type of 

file attached to that note. You can activate the attachment and view it within the applicable 

product by clicking the Show Attachment button. The applicable product (Word, Excel, an 

image editor, Adobe Acrobat, etc.) will be loaded and the attachment will be displayed.  

In order to activate an attachment and use the product with which it is associated, you must 

have that product or a related product installed and functional. For example, if one user has 

attached a Microsoft Word document and you wish to read that document as an attachment, 

you must have Microsoft Word or an equivalent installed and functional on your computer. 

The applicable product is determined by the file associations on your computer. If you have 

associated Word documents with another tool or product, that product can be used to open the 

attachment. 

If you activate an attachment and modify the document within the associated product, the 

attachment will not automatically be put back into People-Trak. This is because the process 

that is editing the attachment works completely independently of People-Trak. That product 

does not know that you wish to move the modified attachment back into People-Trak. If you 
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wish to place a modified attachment back into the note record, you need to save the edited 

attachment to a file, delete the original attachment, and then attach the new file. 

Deleting an Attachment 
An existing attachment can be deleted from a note at any time. When an attachment is 

deleted, it is removed from People-Trak permanently. If you wish to export an attachment so 

that you can use it elsewhere, use the Export feature described in the next section. To delete 

an attachment, select the note with the attachment and click the Delete button. The attached 

file will be deleted from the database and the Type column for that note row will be cleared. 

Exporting an Attachment 
Files that have been attached to notes can be exported from the database for use with another 

product or for any other purpose. For example, if you have attached employee photographs 

and you wish to use them for an employee newsletter or an award, you might wish to export 

the image. 

Notes and Attachments that Originate from Email 

Notes and attachments can be automatically added from the Email feature.  

The following fields on the Send Email screen are applicable for attachments. 

To 
 The email address of the record that is to receive notes. When emails are sent in bulk, 

multiple email addresses can be listed. The email addresses are used to lookup the unique ID 

for the appropriate records so that the note can be added. 

Subject 
 The subject of the email. The entry in this field is added as the first line of the note text in the 

formation shown below. 

 

Email Subject: Subject 

Template  
If a template is being used, this is the name of the template. When the note is created, the 

template with appropriate field data merged becomes the text of the note. The template text is 

added after the first line that was composed of the email subject. Thus, when the notes are 

listed in unexpanded form, you can readily determine which notes were generated by email. 

Text 
 The text of the email becomes the text of the note. The email text is added after the first line 

that was composed of the email subject. Thus, when the notes are listed in unexpanded form, 

you can readily determine which notes were generated by email. 

Attachment 1 
If a file is being attached to the email, the same attachment will be added to the note. This 

field contains the name of the file that will be attached to the notes. 

Attachment 2 
If a file is being attached to the email, the same attachment will be added to the note. This 

field contains the name of the file that will be attached to the notes. 



Workbook 

 

 Notes, Attachments and Tables     5 
 

Attach Document  
If a document is being attached to the email, the same document will be added to the note. 

This field contains the name of the document that will be attached to the notes.  

Note: If multiple attachments are added to an email, there will be a note added for each 

attachment. 

Add Email to Notes  
A check box that allows you to specify whether or not the email and any applicable 

attachment will be added to the notes. Select the check box to add a note to the record 

associated with each email address in the To field. Clear the field to not add a note to the 

records. This check box is defaulted to selected if the Add Email to Notes check box is 

selected for the current module in Module Setup. 

 

Note: If you are in a module whose key record does not have an email address associated 

with it, the record cannot have a note attached to it. For example, if you are in the Training 

Course module, the key record is the training course, which of course is not a person that can 

receive an email. Also, if one of the To recipients does not have a People-Trak record 

associated with it, such as in the case of a vendor, then no record exists to have a note 

attached to it. 

Note Category  
If the email is being sent to notes, this field determines the note category to which the note 

will be added. It is supported by the list of available categories. A note cannot be added 

unless a note category is specified. If the Add Email to Notes check box was defaulted to 

selected, this field is also defaulted to the category specified for the current module in 

Module Setup. 

Tables 

Tables are a key component of People-Trak. Some tables are “system” tables and are not 

modifiable. Typically, these are tables that have standard entries as required by the 

government. An example is the Ethnicity table. Most tables can be modified to meet the 

specific needs of your company. You can edit the tables in a module by choosing the 

Edit/Print Table option on the Tables menu.  

Some tables are used in more than one module. For example, the City table is used in both the 

Personnel Management module and the Applicant Management module. There is one City 

table, so the table entries are the same for all modules that use it.  

Table sharing allows you to have some tables shared by all companies while other tables are 

unique to the current company. For example, the City table would normally be shared if all 

the companies are in the same region while the Retirement table might be entirely unique. 

Likewise, the EEO codes would typically be shared by all companies while attendance 

accounts might not. Tables can only be set to either be shared by all companies or be unique 

to the current company. It is not possible to share a table for some companies and not for 

others. When you are implementing People-Trak, it is important to determine up front which 

tables are to be shared and which will be unique to each company. 

Table Setup 

Table Setup is used to specify the  validation and sharing settings and view  table settings 

such as the module it is associated with, the table type, and whether or not the table  is mass 
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updatable. The settings in Table Setup are enterprise-wide, so if the City table is set to 

Optional validation, it has that setting in all modules and in all companies. 

Table Validation 

There are three validation rules for each table: 

 None 

 Optional 

 Mandatory 

 

No Validation 
When table validation is set to None, any field that was supported by that table is no longer 

supported by that table. The underlying table is ignored and the popup button adjacent to the 

data entry field is not displayed. Turning off validation applies to all fields supported by the 

table. For example, there are multiple fields within Personnel Management supported by the 

City table. If you set validation to None, table support and validation is deactivated for every 

field supported by the City table. 

Note: It is highly recommended that you do NOT set a table to None and then after all data 

entry is complete, set the table to Optional and then reverse-populate. This will merely result 

in bad tables and bad data entry practices. 

Note: If you wish to deactivate table support for a single field without affecting other fields, 

do not use table validation for that feature. Instead, use the Field Customization feature to 

remove table support entirely from that field. 

Optional Validation 
When table validation is set to Optional, it is possible to key a value into the field that is not 

actually in the underlying table. This would be appropriate for fields such as cities, counties, 

or any other type of variable information. This would not be appropriate for fields such as 

departments, jobs, and status codes that are fixed. 

When you key a value into a field using optional table validation and the value does match an 

entry in the table, the value is accepted. When the value does not match an entry in the table, 

the following message is displayed: 

Entry is not in the table, Override Table? 

Because the table is optional, the value can be accepted even though it is not in the table. To 

override the table and keep the entry, select Yes. To discard the entry, select No. 

Note: When an optional table entry is overridden, that entry is NOT moved into the table 

automatically. If you wish to move the entry into the table, you must use the table entry 

feature for that table. 

Mandatory Validation 
When table validation is set to Mandatory, it is NOT possible to key a value into a field that 

is not in the supporting table. If you try, the following message is displayed: 

Entry is not in the table 

When any key is pressed, the entry is discarded and the cursor is returned to the field. 
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Sharing Tables 

The Share Table checkbox in Table Setup  allows you to specify whether or not the table 

should be shared by all companies. Select the Share Table check box to share the table, or 

clear the check box to not share the table. Tables are defaulted to not being shared, so you 

will need to use the Table Setup process to set table sharing accordingly.  

 

Only simple tables can be shared. Complex tables (such as Department) and very complex 

tables (such as Attendance Account) cannot be shared. Tables can only be set to either be 

shared by all companies or be unique to the current company. It is not possible to share a 

table for some companies and not for others. 

Note: If a table is being shared, the Copy option on the File menu is not available, because 

this table is already shared by all companies; there is no reason to copy the table to another 

company. When a table within multiple modules is set to span, auto set selects spanning for 

all tables with the same name. 

Simple Tables 

The majority of the tables provided in People-Trak are “simple” tables. Simple tables support 

the data entry of a single field such as cities, counties, countries, etc.  

The editing and maintenance of a simple table is a process of maintaining the entries in a 

single column grid. You can enter as many values as you want and you can delete or add to 

the list at any time. A screen sample for a typical simple table is shown below. 

 

The operating conventions for the editing of simple tables are virtually identical to those used 

elsewhere in People-Trak. 

Sorting a Simple Table 
With a few exceptions, each of the tables can be sorted in alphabetic order by clicking on the 

column header. If the table is not sorted or is sorted in descending order, it will be sorted in 

ascending order. If the table is sorted in ascending order, it will be sorted in descending order. 
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In addition, you can sort the table in any random order using the Row Up and Row Down 

buttons on the Tool Bar. 

Note: In some cases, you may not want to sort tables at all. The process of popping up a table 

and selecting an entry can be faster if the most commonly used entries are at the top of the list 

and not in alphabetic order. 

Printing a Simple Table 
A simple table can be printed while it is being edited using the Print Screen option on the File 

menu or the Print Screen button on the Tool Bar. It can also be printed from the main 

Maintain Tables screen by using the Print button. Both methods will print the same results.  

Reverse-Populating a Simple Table 
People-Trak provides a unique capability in simple tables to reverse-populate the entries in 

the table from the unique entries in the database tables. This feature is useful when data has 

been imported into the database from another source and that data has populated fields for 

which People-Trak has provided a table. For example, if you have imported city information 

from another source, the city fields in the database will be populated with data from that 

source. To populate the City table with these same values, you can use this feature. 

To use this feature while editing a table, use the Populate Table option from the File menu. 

Using the City table as an example, this feature populates the City table with every unique 

city name from any city field used in the current module and company (all companies if 

sharing is set for the table). There will be no duplicates. Any existing city entries remain, and 

all the cities are sorted in alphabetic order. 

Note: Use of this feature can lead to bad data entry habits. The primary purpose of tables is to 

assist in the correct and controlled data entry of the fields that are supported by these tables. 

If you enter data into the fields manually and then reverse-populate the table, no control of 

the data entry process will have been exhibited. Both the fields and the tables may contain 

errors. It is recommended that this feature be used with appropriate discretion. Because 

complex tables contain more than one field, this feature is not available with complex tables. 

Complex Tables 

Some tables contain more than a single field. For example, the Department table utilizes a 

multi-column grid to maintain the table. A sample is shown below.  
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Other complex tables utilize simple grids like this. The operating conventions for editing 

multi-column grids are the same as any other grid. You can add new table entries by inserting 

rows or adding to the bottom of the grid. You can sort the grid, print the grid or delete rows 

using standard conventions. 

Sorting a Complex Table 
You can sort a complex table by any of the columns in the grid. To sort, click on the column 

header for the desired column. In addition, you can sort the table in any random order using 

the Row Up and Row Down buttons on the Tool Bar. 

Note: In some cases, you may not want to sort tables at all. The process of popping up a table 

and selecting an entry can be faster if the most commonly used entries are at the top of the list 

and not in alphabetic order. 

Printing a Complex Table 
A complex table can be printed while it is being edited using the Print Screen option on the 

File menu or the Print Screen button on the Tool Bar. It can also be printed from the main 

Maintain Tables screen by using the Print button. Both methods will print the same results.  

Reverse-Populating a Complex Table 
You cannot reverse-populate a complex table because it is impossible to determine the values 

for all of the fields. 

Very Complex Tables 

Some tables are quite complex and must utilize multi-tabbed screens. A sample of a training 

course table screen is shown below. 
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Complex tables such as this have special operating conventions. Due to the large number of 

fields required to complete the table, it is necessary to clearly indicate which entry is actually 

being worked on as you move between the tabs and other screens. The technique used is the 

list box that is displayed to the left. This list box remains displayed on all tabs and highlights 

the current table entry. Regardless of which tab you are on, you are working on the table 

entry that is currently highlighted. 

Selecting Items 
You can select any item for editing at any time by clicking the item on the list box. If you 

have changes in process on the original item, the changes are saved before the second item is 

displayed. Except for the New and Delete features, you can change between items whenever 

you wish. 

Adding a New Table Item 
New items only can be added to the table using the New button on the Tool Bar or the New 

option on the File menu when you are positioned to the first tab. When an item is added, it is 

given a temporary code such as NEW1 or NEW2. It is assumed that you will modify the code 

to the desired value as you complete the remaining entries on the screens.  

Deleting a Table Item 
Existing items can only be deleted using the Delete option on the File menu. When an item is 

deleted, the entry is removed from the list box and all fields on the screen are cleared.  

Changing the Code 
Complex tables use a code to uniquely identify each entry in the table. The code must be 

unique. If you attempt to add a code that already exists or you attempt to change a code to 

one that already exists, you will receive a message that tells you cannot do so.  

If you change a code successfully, the code is automatically updated in all related records 

immediately. This is because the link between the table entry and the records depends on the 

code. For example, if you have a job code initially coded as “100” and you change the job 
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code to “1000”, there would be no way to relate the table entry to the records because there 

would no longer be a table entry coded as “100”.  

In larger databases, there can be a slight delay as the records are updated after a code change. 

This should be no longer than two or three seconds. In most cases, the update is transparent. 

Sorting a Very Complex Table 
Complex tables can be sorted using the Sort Table option on the File menu, which is only 

available when editing a very complex table. You can then put the table entries into any order 

you desire. 

Printing a Very Complex Table 
A very complex table can be printed while it is being edited using the Print Screen option on 

the File menu or the Print Screen button on the Tool Bar. Because a complex table’s screen 

has multiple tabs, only the current tab will be printed with the information for all tables. A 

very complex table can also be printed from the main Edit/Print Table screen by using the 

Print button. This method requires that you pick the fields you wish to print and then 

information for all the tables for those fields are printed.  

Reverse-Populating a Very Complex Table 
You cannot reverse-populate a very complex table because it is impossible to determine the 

values for all of the fields. 

Benefit Administration Module and Attendance Account Table 
The Benefit Programs defined in the Benefit Administration module work like the 

Attendance Account table in that the values in the table are returned to the employee record at 

fixed locations. For example, you might define five programs such as: Medical, Dental, Life, 

STD, and LTD. These programs will be the five programs in the employee record and cannot 

be edited there. If you add, delete or sort programs within the module, you need to use the 

Update Benefit Programs activity in the Benefit Administration module to have those 

changes reflected on the Benefit screens.  

Editing Tables 

To edit a table, use the Maintain Tables option on the Tools menu. The following screen is 

displayed.  

  

In the category list on the left, select the category in which the table exists or select the All 

Tables category to display all tables. The tables for the selected category are shown on the 

right. To edit a table, either double-click on the desired table, or highlight the desired table 
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and click the Edit button. If you inadvertently reached this screen, click the Close button to 

exit the screen without making a selection. 

Once a table has been selected, the appropriate screen to edit the table is displayed. Edit the 

table and save your changes. 

Table Locks 
People-Trak uses table locks in a multi-user environment. When a table is opened for editing, 

a lock is assigned to that table. The lock is the user name. The table locked cannot be opened 

for editing by any other user until the table is closed.  

Viewing Tables 

 

To view the contents of a non editable table, either double-click on the desired table, or 

highlight the desired table and click the View button. If you inadvertently reached this screen, 

click the Close button to exit the screen without making a selection. 

Once a table has been selected, the table contents can be viewed, but are display only and 

cannot be modified. 

Printing Tables 

A table can be printed while it is being edited using the Print Screen option on the File menu 

or the Print Screen button on the Tool Bar. The table contents are printed as they are shown 

on the screen. This may or may not match what was most recently saved. To avoid confusion, 

an explicit save is performed when you print. This means that the contents of the screen are 

written to the database prior to printing. Because a complex table’s screen has multiple tabs, 

only the current tab will be printed with the information for all tables. 

A table can also be printed from the main Maintain Tables screen using the Print button. For 

simple and complex tables, the results are sent directly to the Document Viewer and are the 

same as using the Print Screen option when editing the table. For very complex tables, you 

must select the fields that you wish to print. A screen similar to the one shown below is 

displayed. 
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This screen is used to select the fields from the table you wish to print. You can select any 

combination of fields using the check box column. When you are ready to print, click the 

Print button and a report listing the selected fields will be produced. You can use this feature 

to print a different combination of fields from a specific table at any time. 

Table Maps 

A table map supports each table that returns more than one field into a record. Using the Map 

Table Fields utility, you can select which of the specified fields in the destination table are to 

be returned from the source table during data entry. For example, the Position to Employee 

table map returns all of the fields associated with that position when the position is assigned 

to an employee. If you choose not to have a mapped field returned to the employee record, 

you can clear the Enabled check box to not return that field.  

When the fields from a table map are returned to a record, they are display only because 

People-Trak is shipped with all mapped fields flagged as Fixed Display Only. If you do not 

want certain fields returned from a table map, you will need to use the Map Table Fields 

utility to disable those fields from being returned and the Set Display-Only Attribute utility to 

clear the Fixed Display Only flag on those fields. 

Table Mass Update 

Complex tables as well as some of the very complex tables provide a mass update feature. 

This feature causes changes that you have made to the table to be “mass updated” to the 

records in the database. For example, if the manager in one of the departments changes, the 

table is changed to match. However, the names of managers in the corresponding employee 

records are wrong. The Table Mass Update feature is used to change the names of the 

managers in each record to match the name of the manager in the table. Many, but not all of 

the complex tables have this feature.  

In a table that allows mass update, there will be a Mass Update column (on a complex table) 

or a check box (on a very complex table) for each entry. If you select the column or check 

box, changes to that table entry will be mass updated to the records that contain it whenever a 

mass update is done. In any given table, you can mass update some of the entries and not 

others.   
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It is important to understand that the mass update will not affect any history. In a grid-style 

field (such as in employee position history), only the topmost (current) value is updated. 

The Table Mass Update feature can be activated in two ways. Whenever a table that supports 

mass update is changed, the prompt shown below is displayed when you exit the table. 

This table supports mass updating and changes have been made. 
Do you wish to mass update now? 

If you decide not to mass update the table at that time or if you wish to mass update a table at 

any later date, you can use the Mass Update Table option on the Tables menu. When the 

Mass Update Table option is selected, a list of the tables that support the mass update feature 

is displayed. Simply select the table you wish to update. 

As mentioned in the earlier section, a table map supports each table that returns more than 

one field into a record. The Mass Update Table process utilizes these table maps. The Map 

Update Fields process, which is found using the Utilities option on the Administration menu, 

allows the System Administrator to modify a table map. If fields in a table map have been 

disabled, those fields will not be mass updated. 

Note: The Mass Update Table process can affect a large number of records and there is no 

undo capability. It is a good idea to make certain that you have a recent backup before mass 

updating tables.  
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This lesson covers how to use the notes and attachments feature provided with People-Trak. 

Tutorials 
Adding and Deleting Notes: shows how to add and delete notes.  

Working with Categories: demonstrates how the note categories are used to organize notes 

based on the primary data entry screens. 

Attaching a File: shows how to create and attach a file to a note. 

Opening an Attachment: demonstrates how to open an attachment file using the software 

product that was used to create the attachment. 

Deleting an Attachment: shows how to delete an attachment that was added to a note. 
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Tutorial 1.1 – Adding and Deleting Notes 

The Notes screen is essentially a grid with some additional enhancements to support 

attachments and a large multi-line text box. In this lesson, we’ll see how these enhancements 

work. 

1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop 

(or as instructed).  

 

The Select Product Option screen is displayed.  

2. The Position Control and Attendance options should be the only options that are 

toggled on. If not select the Training button to select them. 

3. Click OK 

 

The Login screen is displayed. 

4. In the User ID field, enter DEMO. 

5. In the Password field, enter DEMO. 

 

The Organizer desktop is displayed with the Personnel Management module selected.  

6. Open Donald Stern’s record.  

 

The Personal screen is displayed. Notes within the Personal category are accessed by 

clicking the Category Notes button, which is the third button on the Category Bar. The 

Category Notes screen is available from virtually all of the primary data entry screens and 

sub screens in People-Trak. 

 

Note: The Category Notes button can be turned off for a user by clearing the Notes check 

box in Security Setup. 

7. Select a few of the primary screens and find the Category Notes button. 

8. Return to the Personal screen and click the Emergency button.  

 

The Emergency Contacts screen is displayed. 

9. Find the Category Notes button. It is available here and on other sub screens as well. 

10. Close the Emergency Contacts screen to return to the Personal screen. Click the 

Category Notes button.  

 

The Notes for Personal Category screen is displayed with the notes in descending order 

by note date. As mentioned, the primary component on the screen is a grid, but this grid 

has some special features. The record for Donald Stern already has notes defined for the 

Personal category. Typically, you would add a new note by inserting a row at the top of 

the grid. For demonstration purposes let’s see what happens when a note is added on the 

first blank row. 

11. In the first blank row, click in the Note Date column. 
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You can enter today’s date manually, click the Date popup button or use the Date Stamp 

feature. Let’s use the Date Stamp feature. 

12. Select Cancel to close the Select Date popup. 

13. On the Edit menu, select Date Stamp.  

 

Today’s date is entered into the Note Date column. 

 

Note: You can also invoke the Date Stamp feature by pressing F4. On a new note, if you 

add an attachment or enter the Note Text before entering the Note Date, the Note Date 

field automatically populates with today’s date. 

14. Press ENTER to leave the Note Date column. 

 

The User column is automatically populated with the current user ID DEMO. The User is 

automatically assigned and is for display only. 

15. In the Note Text column, enter the text This is my first note and press ENTER. The 

note is complete. If you want to enter a note for today’s date, there is an even faster way 

to enter a note. Let’s see how this works. 

16. In the next blank row, click in the Note Text column and enter the text This is my 

second note and press ENTER. 

 

The User and Note Date fields are defaulted for you and the note is done! 

 

Now, let’s see how to insert a row rather than just add a row at the bottom of the notes 

grid.  

17. Click anywhere in the first row of the grid.  

18. On the Tool Bar, click the Insert Row button to insert a row.  

 

Note that the User field is completed just as before. Additionally, the Note Date is 

automatically populated with today’s date. This time, let’s enter a note longer than the 

one line we are shown. We could keep typing and have the note wrap or we could use the 

multi-line editor. Let’s try the multi-line editor, which allows you to see all the text you 

are entering. 

19. In the Note Text column, click the popup button to open the multi-line editor.  

 

A Simple Editor screen is displayed. You can now type away for as long as you like. If 

you reach the end of the line, word-wrap will be performed and the cursor will jump to 

the next line. If you press ENTER, the current line will be broken and the cursor will 

jump to a new line. Try these now.  

20. Type a sentence or paragraph that wraps. Then on the second line, press ENTER to start 

another new line. Add a few more lines with the ENTER key and make a nice long note. 

21. When you are finished with your note, click OK to close the editor. 

 

Only the first line of your note is displayed in the grid. If you wish to review the text of 

your note or to add more text, click the popup button to expand the note text area and 

view or edit the text. 
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The Notes screen has been designed to allow you to rapidly view the first line of each 

note relative to the other notes. If you wish to review the note in more detail (if the note 

has more detail), you need only click the popup button. In fact, you can actually browse 

your notes with the mouse. Try this.  

22. Click in the Note Text column of the first row.  

23. Open the editor, read the note text, close the editor. Click on the next line.  

Open the editor, read the note text, close the editor. Click on the next line.  

Open the editor, read the note text, close the editor.  

 

You can use this technique to rapidly browse all notes for any record. 

 

Now that we know how to add notes, let’s see how to delete notes.  

24. Click anywhere in the first row of the grid. 

25. On the Tool Bar, click the Delete Row button to delete the current note.  

26. Use Delete Row to delete the other notes you entered. 

27. Close the Notes for Personal Category screen, saving your changes. 

28. Continue with the next tutorial. 
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Tutorial 1.2 – Working with Categories 

When we entered the notes in the last tutorial, the note category was the category of the 

screen from which the Category Notes button was clicked. Each primary data entry screen in 

People-Trak has a screen category associated with it.  

1. In the Screen dropdown, select Status. 

2. On the Category Bar, click the Category Notes button.  

 

Unlike the Personal category, there are no Status notes for Donald Stern.  

3. Enter a note using the techniques you just learned.  

4. Close the Notes for Status Category screen, saving your changes. 

Try a few other screens and their Category Notes buttons. Some categories may contain 

notes and others may not. If you would like to see the notes within a record, you can do 

so by selecting the All Notes button. 

5. Select the Personal screen, and select the Category Notes button. 

6. Select the All Notes button located to the right of the notes grid. 

The All Notes screen is displayed. This screen is mainly used viewing and printing 

purposes, so all fields are display only and cannot be modified. You may have also 

noticed a Note Category column header listing the categories from which the notes came 

from. 

In addition, this particular grid shares the standard operating conventions of other grids in 

People-Trak. This means that you can sort the grid using any of the column headers. We 

can demonstrate this by sorting our notes by category. 

Note: Grid sorting can be turned off for a user by clearing the Grid Sorting check box in 

Security Setup. 

7. Click the Note Category column header. 

The grid is now sorted by category in ascending order.  

Try selecting the different column headers to sort the notes in other ways. 

These same sorting conventions also work within the category note screens. Let’s take a 

look at how they work for the Notes for Personal Category. 

8. Close the All Notes screen. 

9. On the Notes for Personal Category screen, click the Note Date column header. 

 

The grid is now sorted by date in ascending order. 

 

Like other grids, note rows remain sorted in the most recently sorted order.  

10. Close the Notes for Personal Category screen and open it back up again. 

 

The grid is still sorted by ascending note date within that category. 
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Like in other grids, you can also order the notes in any random order using the Row Up 

and Row Down buttons on the Tool Bar.  

11. Go ahead and use the Row Up and Row Down buttons to change the order of the notes. 

12. Close the Notes for Personal Category screen, saving your changes and stay in 

Donald’s record. 

13. Continue with the next tutorial.  
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Tutorial 1.3 – Attaching a File 

One of the more powerful features of the Notes screen is the ability to attach external files to 

your notes. These external files become an integral part of the record. Attachments can be 

added to any note. Let’s add a note and then add an attachment to it.  

1. In the Screen dropdown, select Status and select the Category Notes button.  

2. Enter a new note and stay on that note row. 

3. Select the Attach button located to the right of the notes grid.  

 

This option displays the Select File screen that is used to select a file. We have created a 

simple Word doc that you can now attach to this note. 

4. In the PT9\SAMPLES directory of your local People-Trak drive, select the 

ATTACHMENT TIP.DOC file. 

 

Internal processing for the attachment is performed. The Type column is updated with 

DOC, indicating that a DOC type file is attached to that note.  

 

In the Note Text field, you would typically want to add a short description of the file 

attached so that you can readily identify the attachment without having to open it. 

5. In the Note Text field, add the following to your existing note and do not press ENTER 

so you stay on this note row:  

 

This note contains an attachment that includes a valuable tip on attachments. 

6. Continue with the next tutorial.  
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Tutorial 1.4 – Opening an Attachment 

Once a file has been attached to a note, the file can be opened for viewing at any time.  

1. Verify that the cursor is positioned to the note row containing the file you attached in the 

last tutorial. 

2. Select the Show button located to the right of the notes grid. 

 

The software associated with the DOC extension, typically Microsoft Word, is fired up 

and the attachment is loaded. This document is a copy of the original document and is 

stored in the ATTACH file under the appropriate enterprise folder. 

 

Note: The attached file is intended to be for display only. If the attached file needs to be 

modified, do so outside of People-Trak. You will then need to delete the current 

attachment from the note and attach the appropriate file. 

3. Close the attachment after reading the tip. 

 

If you attach a file from a software product that you use, another user can only activate 

that attachment if the user also has that software product. For example, if you attach a 

word processing file (as we just did) from your word processor and another user has a 

different word processor, the other user might not be able to view the attachment. The 

Attachments feature is a very powerful feature, but it must be used with appropriate 

discretion. If your organization has standard word processors, spreadsheets, and other 

software products, there will be no problem. 

4. Continue with the next tutorial.  
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Tutorial 1.5 – Deleting an Attachment 

If a file has been attached to a note, you may need to delete it because it was attached in error 

or you need to attach an updated file to the note. Let’s delete the attachment you added to the 

note. 

1. Verify that the cursor is still positioned to the note row containing the file you attached in 

the last tutorial. 

2. Select the Delete button located to the right of the notes grid 

 

The Type column is cleared, showing that the attachment is now deleted from that note. 

If you had another file to attach to this note, you could do so now. 

3. Close the Notes for Status Category screen, without saving. 

4. Close the employee record, without saving. 

5. This concludes this tutorial and lesson.  
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Notes 
  



  

 

 
Lesson 2 

Table Setup 
 
 

Lesson Contents 

Tutorial 2.1 – Specify Table Validation 26 
Tutorial 2.2 – Allow Table Sharing 29 
Tutorial 2.3 – Copy a Table 32 

 

 
This lesson covers key settings in the Table Setup process. 

Tutorials 
Specify Table Validation: shows how to specify table validation and how that validation 

then works. 

Allow Table Sharing: demonstrates how to allow table sharing across companies. 

Copy a Table: shows how to copy a table to another company. 
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Tutorial 2.1 – Specify Table Validation 

There are three validation rules for each table: 

 None 

 Optional 

 Mandatory 

 

In this tutorial, we will learn how each of these validation rules work. 

1. On the Setup menu, select Table Setup. 

 

The Table Setup screen is displayed and includes a list of all of the tables in all modules. 

 

The Module, Table Type and Mass Update columns are for informational purposes only. 

As you learned in the Intro to PT training, there are three types of tables: Simple, 

Complex and Very Complex. The Mass Update column allows you to see if a table is 

mass updatable or not. You will learn more about table mass update in later training, but 

it basically takes changes you have made in a complex or very complex table and updates 

current (not historical) data in records in the database. For example, if the manager of a 

department changes, the records for all of the employees currently in that department 

would be updated to have that new manager name. 

 

As for the settings you can update in this process, we are going to be looking at the 

Validation column in this tutorial and the Sharing column in the next. 

2. In the Validation column for the City table within the Personnel Management module, 

click the popup button and select None from the list.  

3. Close the Table Setup screen, saving your changes. 

4. Open Donald Stern’s record. 

5. In the City field, press F1 to display the Field Name: City help screen. Take a look at 

the Properties and Attributes frame. 

 

The Support Table for this field is the City table we just modified.  

6. Close the Field Name: City screen. 

 

There is no popup button on this City field because validation of  None means there is no 

longer table support on this field.  

7. Enter whatever you want in the field and press ENTER. 

 

Your entry was taken because there is no validation on this field.   

8. Click the Emergency button, which takes you to the Emergency Contacts sub screen. 

9. In the City field for Contact 1, press F1.  

 

The Support Table for this field is also the City table.  

10. Close the Field Name: City screen. 
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There is no popup button on this field because the validation of None on the City table 

applies here also. 

 

Note: As you can see, when you change a table, you might be affecting several fields 

across modules. If you wish to deactivate table support for a single field without affecting 

other fields, do not use table validation. Instead, use the Screen/Field Customization 

feature to remove table support entirely from that field. 

11. Close Donald Stern’s record. 

12. On the Setup menu, select Table Setup. 

13. In the Validation column for the City table within the Personnel Management module, 

click the popup button and select Mandatory from the list.  

 

We are going from one extreme (no validation) to the other (mandatory validation). 

14. Close the Table Setup screen, saving your changes. 

15. Open Donald Stern’s record. 

16. In the City field, click the popup button that is now adjacent to the field.  

 

The Select City screen is displayed listing all of the entries in the City table.  

17. Click Cancel to exit the screen without making a selection. 

18. Try entering Funkytown in the City field.  

 

The following message is displayed: 

Entry is not in the table 

19. Click OK.  

 

Your entry of Funkytown is cleared and the value before your change is restored. You 

can only enter a value in the City field that exists in the City table. No other values are 

allowed. 

20. Close Donald Stern’s record. 

21. Select the Table Setup option again. 

22. In the Validation column for the City table within the Personnel Management module, 

click the popup button and select Optional from the list.  

23. Close the Table Setup screen, saving your changes. 

24. Open Donald Stern’s record. 

25. In the City field, click the popup button. 

 

The Select City screen is displayed listing all of the entries in the City table.  

26. Click Cancel to exit the screen without making a selection. 
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27. Once again, try entering Funkytown in the City field.  

 

The following message is displayed: 

Entry is not in the table, Override Table? 

28. Click No.  

 

Your entry is discarded and the prior value is restored. 

29. Enter Funkytown in the City field again.  

 

The same message is displayed.  

30. This time click Yes.  

 

Your entry is accepted. 

31. In the City field again, click the popup button.  

 

You don’t see your Funkytown entry, do you? When an optional table entry overrides the 

table, that entry is not moved into the table automatically. If you wish to move the entry 

into the table, you must use the table entry feature for that table. 

32. Close Donald Stern’s record, without saving your changes. 

33. Continue with the next tutorial. 
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Tutorial 2.2 – Allow Table Sharing 

Table sharing allows you to have some tables shared by all companies while other tables are 

unique to the current company. For example, the City table might normally be shared if all 

the companies are in the same region but not shared otherwise. When you are implementing 

People-Trak, it is important to determine up front which tables are to be shared and which 

will be unique to each company.   

Only simple tables can be shared. Complex tables (such as Department) and very complex 

tables (such as Attendance Account) cannot be shared. 

Tables can only be set to either be shared by all companies or be unique to the current 

company. It is not possible to share a table for some companies and not for others. 

1. On the Setup menu, select Table Setup.  

 

The Table Setup screen is displayed. 

2. Scroll through the tables and look at the Share Table check box for each.  

 

None of them is selected. This is because People-Trak is installed with all tables set to 

not be shared by all companies. That means that entries in a table will be unique to the 

company.   

3. Close the Table Setup screen and we’ll demonstrate this fact. 

4. On the Tools menu, select Maintain Tables to display a list of the available tables.  

 

Let’s assume that we have companies in different regions, so we want the City table to be 

unique to each company. 

5. Select the City table and click Edit.  

 

Note that there is no city named Whoville.  

6. Close the City table and close the Maintain Tables screen. 

7. On the File menu, select Select Company and switch to the ARCHIVE company.  

8. Now open the City table for editing again.  

 

The table is blank. That is because the City table is not shared with the ACTIVE 

company. The cities listed for the ACTIVE company are not applicable to the ARCHIVE 

company. 

9. Add a city named Whoville to the table. Close and save the table. Close the Maintain 

Tables screen. 

10. Use the Select Company process to return to the ACTIVE company.  

11. Open the City table. 

 

Once again, Whoville is not listed. That’s because Whoville is associated with the 

ARCHIVE company and not the ACTIVE company.  

12. Close the City table and the Maintain Tables screen. 
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13. Open Donald Stern’s record for editing.  

14. In the City field, click the popup button to display a list of the available cities.  

 

This list will be identical to the list defined for the ACTIVE company and Whoville is not 

listed. If we were to change companies back to the ARCHIVE company and then 

displayed a list of the available cities at any City field, the list would contain only 

Whoville. 

15. Close Donald Stern’s record. 

 

We just saw how tables work when they are not shared. Now, let’s share a table and see 

how that works.  

16. Use the Select Company process to return to the ARCHIVE company. 

17. Now open the County table for editing.  

 

It is empty because the table is not being shared and there are no entries for this company 

yet. Even though the ACTIVE company has entries, the ARCHIVE company does not. 

18. Close the table and the Maintain Tables screen. 

19. On the Setup menu, select Table Setup. 

 

The settings in Table Setup are enterprise-wide, so if the County table is set for sharing 

while in the ARCHIVE company, it has that setting in all companies. We could have 

gone to the ACTIVE company and changed this setting, and it would have had the same 

effect. 

20. For the County table, in the Personnel Management module, select the Share Table 

check box to activate sharing.  

Note that sharing has also been activated for the County table in the other modules as 

well. 

21. Close the Table Setup screen, saving your changes. 

22. Open the County table for editing. 

 

The County table here in the ARCHIVE company now has the same entries as the 

ACTIVE company because this table is now shared by all companies.  

23. Add an entry to this County table with any County Name you want. 

24. Close the County table, saving your changes.  

25. Close the Maintain Tables screen. 

26. Use the Select Company table to switch to the ACTIVE company. 

27. Open the County table for editing. 

 

You will see your entry while in the ACTIVE company as well. Remember, there is one 

table that is being shared by all companies now. 
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28. Go ahead and delete the entry you made. 

 

29. Close the County table, saving your change. 

 

The County table is now updated and the same for all companies. 

30. Close the Maintain Tables screen. 

31. Continue with the next tutorial. 
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Tutorial 2.3 – Copy a Table 

In the previous tutorial, we said that we were not going to share the City table because our 

companies were in different regions. But what if you have two companies in which you 

would like to have identical (or at least similar) entries, what can you do? You can’t share the 

table because that table would be the same in all companies. What you can do is get the table 

entries the way you want in one of the companies and then copy that table to the other 

company. Let’s give this a try. 

1. On the Setup menu, select Table Setup.  

2. Select the City table for the Personnel Management module. 

3. On the File menu, select Copy Table to Company. 

 

The Select Company screen is displayed. 

4. Select the ARCHIVE company. 

 

The City table entries for the ACTIVE company are copied to the City table in the 

ARCHIVE company.  Let’s go verify this. 

5. Use the Select Company process to switch to the ARCHIVE company. 

 

Before we take a peek at the City table, remember from the last tutorial that we only had 

Whoville in the ARCHIVE company’s City table. 

6. Open the City table for editing. 

 

Voila! The entries from the ACTIVE company are now over here. Whoville is no more 

because the Copy option clears any entries in the “to” table before the copy is done. If 

you did want unique entries in this table for this company, you could enter them now; 

since this table is not shared, you are only affecting the table entries for this company. 

7. Close the City table and the Maintain Tables screen. 

8. Switch back to the ACTIVE company. 

9. This concludes this tutorial and lesson 
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This lesson covers how to maintain both simple and complex tables as well as how to print 

tables. It also covers the reverse population of a table and the mass update of a table to the 

database.  

Tutorials 
Edit a Simple Table: shows how to edit a simple table using standard grid conventions. 

Reverse Populate a Table: demonstrates a powerful method of populating a table with the 

existing unique values in the records. 

Print a Table: shows how to print a table two different ways. 

Working with a Very Complex Table: shows the techniques required to add and delete 

records in a very complex table. 

Mass Update a Table: demonstrates how to mass update a complex table to the records in 

the database affected by that table. 
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Tutorial 3.1 – Edit a Simple Table 

People-Trak provides a wide range of tables for tracking commonly used information. As you 

have seen in prior lessons, the tables are used to provide this information to records in a 

standard and consistent manner. You have already seen all the operating conventions used for 

tables. This tutorial will be a quick refresher. 

1. On the Tools menu, select Maintain Tables. 

 

The Maintain Tables screen is displayed, which has a list of categories on the left side 

and a list of the tables in the selected category on the right side. The All Tables category 

is initially selected and a list of all the tables in the current module to which you have 

access is presented in alphabetic order on the right. 

2. Highlight the City table and click Edit (or just double-click on City) to begin editing that 

table. 

 

The City table is a typical single field table. The City table uses standard grid 

conventions. For example, you can insert rows, delete rows and sort rows.  

3. Try inserting, deleting, moving and sorting rows now.  

 

Note that the sort function within tables assumes ascending order, but a simple click on 

the City Name heading will change the sort to descending if you prefer. The order of the 

entries you see here is what you will see when you use the popup button on a field that is 

supported by this table. You can move the most commonly used entries to the top, if you 

choose. 

4. In the first blank row, make an entry.   

 

All of the field edit conventions are identical to those you have seen before.  

5. Select some of the text you just entered and try using cut and paste. 

6. On the File menu, click Exit to exit the table.  

 

This will save your changes, but not to worry, we will be cleaning up the City table in the 

next tutorial.  

7. Edit the Department table. 

 

This Department table functions identically to the City table except that there are multiple 

fields in each row.  The Department table is an example of a complex table. 

8. Exit the Department table.  

9. Continue with the next tutorial. 
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Tutorial 3.2 – Reverse Populate a Table 

Normally, you create tables by entering the values directly into the table. There is another 

way to populate a table. This is normally useful when a table is activated after data entry has 

been performed, or when records have been imported and you wish to build your table from 

the data already present in the records. Here is how you do it. 

1. Edit the City table.  

2. On the Tool Bar, click the Delete Row button to delete all of the existing rows.  

3. On the File menu, select Populate Table.  

 

The following message is displayed: 

This option will populate the table with unique entries from all related fields for 
the current company. Do you wish to continue? 

4. Click Yes to populate the table.  

 

The table is then populated with every unique city name from any city field used in the 

current module and company (all companies if sharing is set for the table). There will be 

no duplicates. 

 

Note: When we set this table up, we cleared the table prior to populating. This is not 

necessary, but was used for demonstration purposes. If there are unique entries in the 

table when the populate option is selected, the unique entries will remain. Let’s try it. 

5. Clear the table again.  

6. Then add three unique city names such as XXX, YYY, and ZZZ. 

7. On the Tool Bar, click the Save button. 

8. On the File menu, select Populate Table and click Yes.  

 

Note that the new values from the existing records are added to the unique records in the 

table and that all of the records are sorted in ascending order. Our “X”, “Y” and “Z” 

cities will be at the bottom. 

 

Note: The populate feature should be used carefully as it can lead to bad data entry 

habits. Do not run this feature regularly on the same table so that the table will match the 

fields in the records. That is exactly the opposite of what you want. Your tables are used 

to ensure proper validation of the data that is entered into the records. 

 

This feature is only available on the simple tables. You cannot populate complex or very 

complex tables in this manner. 

9. Use the Delete Row button to delete the XXX, YYY and ZZZ entries. Stay in the City 

table. 

10. Continue with the next tutorial. 
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Tutorial 3.3 – Print a Table 

There are two ways to print tables. You can print the table while you are editing it, or you can 

print the table from the Maintain Tables screen. We’ll do both.  

1. You should still be editing the City table.  

2. On the Tool Bar, click the Print Screen button to print the screen.  

 

You have effectively printed the City screen, which is the same as printing the City table. 

This is because the City table is a simple table. The difference between printing a table’s 

screen versus printing a complete table will be more evident when looking at complex 

tables in just a bit. 

3. Close the Document Viewer. 

 

Now let’s print the table the other way.  

4. Close the City table.  

 

The City table should still be highlighted in the table list on the Edit/Print Table screen. 

5. Click the Print button.  

 

The table is printed directly from the Maintain Tables screen and the contents are the 

same as the table printed from within the editing screen.  

 

As mentioned earlier, the City table is an example of a simple table. Let’s print a complex 

table. 

6. Close the Document Viewer. 

7. Now edit the Training Course table. 

 

As you can see, this table is a lot more complex. In the next tutorial, you will learn more 

about these kinds of tables. For now, we are just going to print one. 

 

First, let’s see what printing the table does.  

8. On the Tool Bar, click the Print Screen button to print the screen.  

 

The information on all of the tabs for the selected entry of the Training Course table is 

printed. The key here is that only the information for the selected entry is printed. The 

information for all of the entries was not printed. 

 

Now, let’s use the Print option on the main screen and see the difference. 

9. Close the Document Viewer and close the Training Course table. 

 

The Training Course table should still be highlighted in the table list on the Maintain 

Tables screen. 

10. Click the Print button.  

 



Maintaining Tables 

 

 Notes, Attachments and Tables     37 
 

The Table Report screen is displayed. Since there are so many fields of information in 

complex tables, you are required to choose what information you would like to see.  

11. Select the check boxes for any five fields and then click the Print button. 

 

A report is generated that includes those five fields for all table entries. You can see that 

the print options generate different results for complex tables. 

12. Close the Document Viewer, close the Table Report screen, and then close the 

Maintain Tables screen. 

13. Continue with the next tutorial. 
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Tutorial 3.4 – Working with a Very Complex Table 

Some tables have many fields and cannot be maintained with a single grid. In some cases, a 

table is actually composed of multiple parts: a main record and a series of detail records. 

These very complex tables are unique, but share a common set of operating conventions.  

1. On the Tools menu, select Maintain Tables and then edit the Location table.  

 

The Location table is one of the “simpler” very complex tables and is a good table for 

demonstration. All of the very complex tables provide a list box that contains the existing 

table codes and either one or more tabs to maintain the information. The Location table 

has just one tab. 

 

The list box on the left is used to select one of the codes for editing. When the screen is 

first displayed, the first code is automatically selected for you.  

2. Select a different code and note that the fields are refreshed for that code.  

3. Change one of the values for the code you have selected and then select another code. 

 

The change you made is saved when you moved to the other code just like changes are 

saved on the primary data entry screens when you move between records. 

 

When there are multiple tabs of information, the list box is displayed on each tab so that 

you can see which code is being edited. You can move between the tabs changing any of 

the information associated with the code. The changes are saved when you change to 

another code or exit the table. 

 

With complex tables you cannot insert a row when you wish to create a new entry 

because there is no grid. Instead, there is a New Location (or New Department, New 

Division, etc.) button on the Tool Bar and a New Location option on the File menu. 

When this feature is used, a blank record is added to the table and is given a temporary 

code such as NEW1, NEW2, etc.  

4. On the Tool Bar, click the New Location button to add a new location.  

 

The location code NEW1 is added to the list box and is placed into the Location Code 

field. Normally, you would continue adding the information for this location by changing 

the code to a valid name and by completing the remaining fields as necessary. At this 

point, the new location has been added; you are actually editing a blank record.  

 

We just added a new record to a table. Now, let’s learn how to delete it. 

5. On the File menu, select Delete Location or on the Tool Bar click the Delete Location 

button to delete the NEW1 location.  

 

The following message is displayed: 

Delete the highlighted table item? 

6. Click Yes.  

 

Once the record has been deleted, the next record in the list box is automatically selected.  
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You can also sort very complex tables, but since there is no grid, you can’t sort these 

tables like the simpler ones. 

7. On the File menu, select Sort Locations. 

 

The Sort Locations screen is displayed. 

8. Click the Row Down button to move the first location down to the second entry.  

9. Click Apply. 

 

The locations are now sorted in the order you wanted. When you go to the field supported 

by this table and use the popup button, the entries will be in this order. 

10. Close the Location table, and click No when asked about mass updating.    

11. Stay in the Maintain Tables screen for the next tutorial.  

 

Some of the other complex tables are more complex in that they have more tabs and even 

sub screens and buttons. However, the operating conventions match those used 

elsewhere. You need only apply the knowledge you have already acquired. 

12. Continue with the next tutorial.  
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Tutorial 3.5 – Mass Update a Table 

Complex tables as well as some of the very complex tables provide a mass update feature. 

This feature causes changes that you have made to the table to be “mass updated” to the 

records in the database. For example, if the manager in one of the departments changes, the 

table is changed to match. However, the names of managers in the corresponding employee 

records are wrong. The Table Mass Update feature is used to change the names of the current 

managers in each record to match the name of the manager in the table. Many, but not all of 

the complex tables have this feature. In a table that allows mass update, there will be a Mass 

Update column (on a complex table) or a check box (on a very complex table) for each entry.  

If you select the column or check box, changes to that table entry will be mass updated to the 

records that contain it whenever a mass update is done.  

It is important to understand that the mass update will not affect any history. In a grid-style 

field (such as in employee position history), only the topmost (current) value is updated. The 

fields to be updated by mass update are determined by that table’s mapping, which can be 

changed using the Map Table Fields utility. 

Note: The Mass Update Table process can affect a large number of records and there is no 

undo capability. It is highly recommended that you perform a backup before mass updating 

tables.  

1. You should still be in the Maintain Tables screen. Edit the Department table.  

 

The Department table is displayed and the Mass Update column is selected for all of the 

codes. If you wanted to mass update some codes and not others, you can easily clear the 

check box for the codes you do not want to mass update. We want to mass update 

changes to any department, so we will leave that column as is. 

2. Change the Manager for Department 600 from Rhoda E. Tyrell to Frank W. Adams. 

 

Note: You will need to use the popup button to make this change. You cannot type the 

name directly into the field because it is expecting the employee number. 

3. Close and save the Department table.  

 

The following message is displayed: 

This table supports mass updating and changes have been made.  
Do you wish to mass update now? Yes or No 

4. Click No for now.  

 

We want to take a look at an employee in Department 600 and see how the manager has 

not changed there yet. Normally, you would want to answer “Yes” to this question when 

changing table data. 

5. Close the Maintain Tables screen. 

6. Open Donald Stern’s record. 

7. In the Screen dropdown, select the Position screen. 

8. Click anywhere in the first row of the Position History grid, and then click the 

Organization: 1 button.  
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Note that the Department 600 Manager is still Rhoda E. Tyrell. 

9. Close Donald’s record. 

10. On the Tools menu, select Maintain Tables. 

11. Select Department from the list of tables and click Update.  

 

The following message is displayed: 

Table Mass Update Complete  

12. Click Close to close the Maintain Tables screen. 

13. Go back into Donald Stern’s record. 

14. In the Screen dropdown, select the Position screen. 

15. Click anywhere in the first row of the Position History grid, and then click the 

Organization: 1 button.  

 

Note that the Department 600 Manager is now Frank W. Adams, which matches the 

Department table.   

16. Close Donald’s record. 

 

Let’s set the Department 600 Manager back to Ms. Tyrell.  

17. On the Tools menu, select Maintain Tables and then edit the Department table. 

18. Change the Manager for Department 600 back to Rhoda E. Tyrell. 

19. Close and save the Department table.  

 

The following message is displayed: 

This table supports mass updating and changes have been made.  
Do you wish to mass update now? Yes or No 

20. This time, click Yes.  

 

All employees currently in department 600 will now have the Manager field for that 

department updated to be Rhoda E. Tyrell in their employee record. 

21. Click OK. 

22. Close the Maintain Tables screen. 

23. Exit People-Trak. 

24. This concludes this tutorial and lesson. 

 
 


